Beijer HMI RMC200 Connection with Modbus

This document demonstrates how to establish a basic ethernet connection between a Beijer X2 pro 7
HMI and Delta RMC200. The user will learn how to send data to RMC registers from the Beijer HMI in
the form of command data, read register data from the RMC with the HMI, and graph basic RMC plot
data on the HMI.

Equipment used:

e Delta RMC200 Motion Controller
e Beijer X2 pro 7 HMI

e Ethernet switch

e PC connected to ethernet switch

e RMCTools Software

e BeijeriX Developer 2.40 Software
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HMI Communication Settings

1. Connect the Delta RMC and Beijer HMI to an ethernet switch.
2. OpeniX Developer 2.40. Create a New Project.
3. Choose a Target HMI (X2 Pro 7 in this example).

r Choose Target
Choose your target in the menu

below

4 Y

X2 pro7 ext =

Target rotate |0 v
Touch operater panel

7" TFT, 16:9, 800 x 480 pixels

Hﬂ

Application memory: 1.5 GB nis
Interfaces: 1 x 10/100 Mbps Ethemnet
1xUSE
3 x serial ports (R5232/R5485/R5422)
1xSD card slot S
1 x expansicn port

I . - _ - |I s

X2 pro 12 X2 pro 15 X2 pro 21 XZcontmld \,OS”"C"‘

£
A A
4. Choose the Controller (Modicon Modbus Master for this example) which the RMC will emulate.

r/— Choose Controller —\1
Choose your preferred controller

or OPC server in the menu below

[
(® Controllers 0

Select brand

Select protocol

e veservo
& woicon
B nmea 0183
% omron

(Modbus Master

Modbus Slave RTU/TCP

' OPC UA Server
URL:

A

ext =
= re\nous

nisi

L

dlCcel

5. Name the project and click Finish.
6. On the left side of the screen, in the Functions pane, click Tags.



Secunity

acirro+ Configuration

Alarm Server

Multiple Languages

Tags

7. Inthe newly opened Tags panel, select the Controllers Ribbon.
8. With Controllerl selected, click Settings to open a dialog box.

Screen] % Tags X

=

[ags | Controlers I[ Triggers || Poll Groups || Index Regsters |

[ Home |
[ —|
Add Delete [Cﬂnlm\len. ||l Settings... “IShuwSe\e(ﬁunm v|
Name D Active
» S v
Modbus Master X

Settings | Statons |
Modbus Master 5.22.00

£ Settings
Communication mode
Default station
Modbus protocol
32-bit word mapping
Addressing
Start address
Silent tme {ms)
Coils/nput status bits per message (read)

Ethernet TCP/IP
0

RTU
Little-endian
Decmal

1-hased

0

128

Coilsfinput status bits per message (wri... 1

Holding/input registers per message (fe... 16

Holding/input registers per message (w...

Force function code 0x10 Disable

String swap Enable k1
oK | Cancel Apply Help




9. On the Settings tab, set the following:

a. Communication Mode to Ethernet TCP/IP

b. 32-bit Word Mapping to Little-endian
c. Start Address to 1-based

Make sure the rest of the options match the below images.

Modbus Master *
Settings || Stations | [y
Modbus Master 5.22.00

B Settings =
Communication mode Ethernet TCP/IP |
Default station a
Modbus protocal RTU
32-bit word mapping
Addressing Dedmal
Start address
Silent time {ms) 0
Coilzfinput status bits per message (read) 128 =
Coilsfinput status bits per message (wri... 1
Holding finput registers per message (re... 16
Holding finput registers per message (w... 8
Force function code 0x10 Disable
String swap Enable >

oK | Cancel | Help |

10. In the Modbus Master dialog box, on the Stations tab, set the Station 0 IP Address to the IP
Address of the Delta RMC (Steps to find the RMC IP address are shown in Setting the RMC IP

Address on pg. 4).

Settings | Stations |
Station | IP Address Port Mode
il 192.168.4.191 502 2
Add
ok | Cancel | Ay | Hep

11. Click OK.

12. The Controller name can also be set, in this example we set the name to DeltaRMC200.




Setting the RMC IP Address

13. To find the IP Address of the RMC, connect the RMC to the ethernet switch and go online with it
in RMCTools. On the left side of the screen, in the Project View pane, expand Modules and
double-click the CPU module.

Project Wiew * 0 X
Elgj Project - [Project1]® -
-l RMC200 - [Press200]
|_:_||_ﬂ Modules
----- -2 Wiew Modules

[ [Base] B11
..... I [0] PS40 (Power)

----- i [1] CPU4D [CPLR
..... i [2]58

..... i [3]CVE

..... i [4] Cad

[ Axes

-5 Programming

----- & Curves

E Addecre bd~nr W
Actuator Wiew * 1 X
14. On the Ethernet page, set the RMC IP address settings.
[1]1 CPU4D (CPU) Properties x
. A
General Ethernet settings for the selected module
Ethernet 1P Settings
Etherlet/IP Select a method to assign an IP address: Current IP Address
PROFIMET () Obtain IP address using DHCP Address Method:  Static Address
Control Loop (C) Obtain IP address using BOOTP IP Address: 192.168.4.191
(®) Use the following IP address Subnet Mask: 255.255.240.0
Feature Key Default Gateway: 0.0.0.0
IP Address: 192,168.4,191
Date and Time
Subnet Mask:
sD Card 255.255.240.0 Open Communication Status...
Display Screen Defalt Gatenay: View IP Settings for PC...
Firmware allow changing IP address over Ethernet (changes over USE are always allowed)
Tip: Use the 'Display Screen’ property page to enable or disable the ability to change the IP
address from the CPU display screen,
Ethernet Protocol Mode
Select one of the following modes for this controller:
(@ Etherliet/IP Mode
Optimized for EtherNet/IP. All other protocols are supported except PROFINET I/O and
Media Redundancy Protocol (MRP).
(C) PROFINET Mode
Optimized for PROFINET. All other protocols are supported except EtherMet/TP I/0 and
Device Level Ring (DLR).
Ethernet Settings
Select the operating mode for each Ethernet port. hd
Cancel Help




Reading From the RMC

We will create HMI tags for reading from the RMC. The information we will be communicating are the
actual position of Axis 0 along with the In Position and Halted status bits.

15. Return to the Tags panel. Click Add to add another Tag. Create a total of three Tags.
16. Rename the three Tags PositionFeedback, InPositon, and Halted.
17. Set the Controller Data Type for:
a. InPosition to INT32
b. Halted to INT32
c. PositionFeedback to FLOAT
18. Change the Access Right for each Tag to Read.

Screen] % Tags X

=
-

J' Tags || Controllers || Triggers || Poll Groups || Index Registers ]

J Home |
Columns Visible Filter
‘ Add 2 Delete - Scaling [] Cthers
[] Data Exchange
Tag Controllers Scaling
Mame Data Type I Access Right I bata Type I DeltaRM. .. Offset Gain Read Expression ‘Write Expression
InPosition DEFALLT Read INT32 400001 a 1
Halted DEFALLT Read INT32 40 a 1
1 | PositionFeedback DEFAULT Read FLOAT : 0 1

19. To correctly assign Tags to addresses in the RMC use the Indirect Data Map in RMCTools.
20. In RMCTools, in the Project View pane, double-click Address Maps and choose the Indirect Data
Map. Right click on the Reg # column, point to Address Format and choose Modbus.

Reg # Map To Description Current
0 1 MERAALS A ~eeb==n Status Bits 16704002241
1 Cut Actual Position (pu) 9,999959
2 - Paste
2 Delete
5 Address Format » DF1 (Allen-Bradley)
g 13 [EC
7 i5 + Modbus
8 FINS (Omron)
9 19
C —

21. The Indirect Data Map allows the user to map and write/read specific registers. The Register
number is listed in the Reg # column. For this example, we will use Registers 1 and 3 (The actual
internal register values are 400001 and 400003 but are truncated for readability).



22. Inthe Map To box, click the ..| button to open the Address Selection Tool window.

| F Address Maps X | 7{& Axis Tools |E1rer'|t Lag |SPIot Manager |

"

Indirect Data Map
& Modbus
& FINS (Omron)
& DF1 (Allen-Bradley)
& PROFIMET Data Records
& IEC

=

LN

[0 T S L T N

)
m
[t=]

L=T I I % B T R

4

Map To

Description

swmDzss.0 | | [ Iouter Status Bits

%eMDZ56. 20

"Outer0 Actual Position {pu)

Current
16704002241
9.999989

23. The Address Selection Tool window allows the user to easily find and select the necessary

register. In this case select:
a. Axis0 Status Bits

b. AxisO Actual Position

Add both, click OK.

Address Selection Tool

Available Registers:

=1 Axes
-0 0 - Axis0
=1 Stz
-----
----- 4+ Error Bits
=-_1 Feedback
-----
----- 4 Actual Velodty
----- @ Actual Accel

----- 4 Raw Counts

----- 4 Actual Position, Unfiltered
----- @ Actual Velocity, Unfiltered
----- 4 Actual Accel, Unfiltered
----- 4 Actual Position, Control
----- @ Actual Velocity, Control
----- 4 Actual Accel, Control

----- @ Transducer 0 Status A

----- 4 Transducer 0 Status B

----- 4 Custom Counts

----- € Custom Status

[+-{_1 Control

(- Output

[+-{_1J Target

[+-{_] Parameters

[#-{_] Command Registers

F-_d 1- Axisl

Registers to Add to Indirect Data Map:

Add > I

L

Address: %eMD256.21

b show | Selected Address Details:

%MD 255.0 - AxisO Status Bits

%eMD 256, 20 - Axis0 Actual Position

Duplicate for axes ... |- iy

OK Cancel

Help

T

24. Click the Download to Controller

controller.

button on the Address Maps toolbar to download to the




25. Return to iX Developer. On the Tags tab, set the register addresses for the InPosition, Halted,
and PositionFeedback Tags to match the register addresses in the Indirect Data Map. In this

case, 400001 and 400003, as shown below.

Columns Visible

Filter

InPosition

DEFALLT

Read INT32

INT32

[ Add [ Delete - Scaling [] Others
[[] Data Exchange
Tag Controllers Scaling
Mame Data Type Access Right | Data Type DeltaRM. .. Offset Gain Read Expression Write Expression
400001 a 1

400001

Halted DEFALLT Read i
| Postonfescback  DEFAULT  Resd 00003 I N I

i}

Configuring Status Bits
The InPosition and Halted Tags in their current configuration will print all status bits in hexadecimal. We
will modify the Tags so that they mask and only print the InPosition and Halted status bits, respectively.

26. In the Tags pane, in the Columns Visible section, check Scaling to reveal more options.

Home |

Filter

Columns Visible

[ Add - [ Delete  ~| [[AScaling | [] Others
[[] Data Exchange
Tag Controllers Scaling
Mame Data Type Access Right | Data Type DeltaRM. .. Offset Gain Read Expression Write Expression
InPosition DEFAULT Read INT32 400001 a 1
DEFALLT Read INT32 400001 a i
el

Halted
bestovesbek CAMT ke Row o

27. In the InPosition row, click the cell in the Read Expression column and click the three-dot

ellipsis. A dialog box will appear.

28. Click Load and another dialog box will appear. From the drop-down list, expand Bit Operators

and choose BitOIsSet, then click OK.



Select Expression

Select a Project Expression ...

Expression Code

Mew Edit

Library Expressions

I

ave

Load

Insert Tag ...

Insert Operator ...

Insert Function ...

Delete

OK

| | Cancel

) Expressions

Load a Single Expression from Library ...

BitOIsSet
None
Selects no expression

= Bit operators

BitQlsSet
Returns 1 if bit 0 is sef elze 0
Bit1lsSet
Returns 1if bit 1 is set else 0
Bit2lsSet
Returns 1ifbit 2 s set else 0
Bit3IsSet
Returns 1if bit 3 is sef elze 0
BitdlsSet
Returns 1if bit 4 is set else 0
Bit3lsSet
Returns Tif bit 5is setelse 0
 Bit6lsSet
Returns 1if bit 6 is sef elze
Bit7lsSet
Returns 1if bit 7 is set else 0
Bit8lsSet
Returns 1if bit 8 is set else 0
Bit%lsSet
Returns 1if bit 9 is sef elze
Bit10lsSet

29. Name the expression if prompted and click OK.
30. The Expression should look like the following.

X Expressions

Select Expression

BitDlsSet

Expressicn Code
(value & 0x1) == 0x1

= | Mew | ‘ Edit ‘ ‘Delete‘

Library Expressions

| Load | ‘ Save ‘ ‘Delete‘
Insert Tag ... M
Insert Operator .. M
Insert Function .. i
ok || Cancel

31. Click OK to close the dialog box.




32. Repeat steps 24-28 for the Halted tag. Use Bit15isSet for the expression.
33. The Tags should now look like this:

Home |

Columns Visible Filter

2 Scaling [] Others
[] Data Exchange

[ Add

Tag Controllers Scaling
Mame Data Type Access Right | Data Type DeltaRM. . Offset Gain Read Expression Write Expression
InPosition DEFALLT Read INT32 400001 1 BitDIsSet
: ———_——- ——
PositionFeedback DEFALLT Read FLOAT 400003
[

The connections for RMC reads from the HMI have now been set up. Next, we will connect our created
Tags to objects on the screen.

Testing Communications for Reading

An example screen shown below has been created using Check Boxes and a Linear Meter. The Linear
Meter has been set to have a minimum value of 0 and maximum value of 20 to match the minimum and
maximum travel in RMCTools. The Check Boxes are unmodified.

DELTA

COMPUTER SYSTEMS, INC.




34. Assign one Check Box to the InPosition Tag and the second Check Box to the Halted Tag by
selecting each object and using the Property Grid. Assign the Linear Meter to the
PositionFeedback Tag.

Property Grid > 0 x Property Grid - I X
Search L b w [ 4] search L P )<
Tag InPosition Tag PositionFeedback

Text /InPasition ! 485 || Minimum 0 |
Multiline | Maximum %
Font size 12 - Major ticks o *
Font family Tahoma v ||| Minor ticks | ]
Width 75 Style Chrome_Compact -
Height 15 Crientation Horizontal 9
Visibility & Fonit family Tzhoma v
Security groups required | Select Security Groups.. = Foniboe 12 -
| | Fent calor Il - |cooooo

> Text

e = -
Scale color Il - |cooooo

Outine .
Wit 55
[ amatons O 03
Security groups required | Select Security Groups..  ~

35. Now we can test the communications. In iX Developer, on the Project tab, click Download,
select the target device in the dialog box, and click Download.

) - b b |iXDeveloper 240 SP5 - test2 (Triol)

Home JESSERM Sysiem  Insert  View  Dynamics

= '] = Project Name test2.

-5 = J;

b b @ =N | BE Bs [ E

| ProjectTitle test2

Rebuild Run Simulste Debug | Download [Upload Export | Back Up Settings Refersnced
stabase Project Aszemblies

plorer

o

(Tage | Controers [ Trggers | P croups | ndex Regsters |

— Download Project X
rome |
Choose a target to transfer the project to —
Add Delete i - D ) I =
| Search targets .
\ 3
r Target Type  IP Address Project Name Settings,
Name get Typ I gs Select

> DeltaRMC200 X2pro7  192.168.4.65 test2 ‘ @ | v

acirmo+ Cenfiguration

Alarm Server

Multiple Languages

Security

1. Selection
Close
S

Tags




36. Test the RMC reads from the HMI by sending simple move commands to AxisO in RMCTools. The
Position meter should move in real-time and accurately represent the position of the AxisO
cylinder. The In-Position check box should be checked when the axis has finished moving and

should be unchecked while it is moving. The Halted Check Box should remain unchecked unless
an axis halt occurs.

After confirming that reading these two objects works, tags will now be created for writing to the
RMC.

11



Writing to the RMC

Due to the Beijer HMI’s constant polling, scripting must be used to create functional objects and

connections for writing to the RMC. First, we will create tags and link them to the RMC Address Map for

the writes to the RMC.

37. To determine the register addresses for these tags, return to the Address Maps in RMCTools.

38. Choose the Modbus Address Map and expand the 402049 register address for Command Area

Axis 0 as shown.

i

W Indirect Data Map
@ Modbus
WS (Umron
B DF1 (Allen-Bradiey)
B PROFIMET Data Records
& IEC

E Address Maps X | A Ais Tools |Event Log |gpmt Manager |

Start Address End Address Registers

400001 402043 1024
Bl 402048 402688 320
=] 402049 402068 10
402042 402050 1
L\x’ 402051 402052 1
402053 402054 1
402055 402056 1
402057 402058 1
402059 402060 1
402061 402062 1
402063 402064 1
402085 402086 1
402057 402068 1

402089 402088 10

Map To
%MD&.0
%MD 16.0
%MD 16.0
%MD 16.0
%MD 16.1
%MD 16.2
%MD 16.3
%MD 16.4
%MD16.5
%%MD16.6
%MD16.7
%MD 16.8
%MD 16.9
%MD 16. 10

Description
Indirect Data Map, registers 0-1023

Command Area, Axes 0-31

Command Area, Axis 0 {Outerd)

Outer) Command

Outer0 Command Parameter 1
Outer0 Command Parameter 2
Outer0 Command Parameter 3
Quter0 Command Parameter 4
Outer0 Command Parameter 5
Outer0 Command Parameter 6
Outer0 Command Parameter 7
Outerd Command Parameter &

Outer) Command Parameter 9

Command Area, Axis 1 {Outer1)

39. The AxisO Command parameters are listed from 402049 to 402067. Each Command Parameter
corresponds in order as shown in the Command Tool. For a Move Absolute (20), AxisO Command

(403049) is the Command Number (20), AxisO Command Parameter 1 (402051) is the Position

value, Command Parameter 2 (402053) is Speed, and so on (Direction, 402059, is not necessary
for linear axes like in this example).

Command Tool - Press200 * O X
A~ - @& - Send Al
Axisl M
Cmd: |M-:nre Absolute (20)
Position (pu): 15
Speed (pujs): 5
Accel Rate (pu/fs3): 5
Decel Rate (pufs2): 5
Direction: Mearest (1)

€- B-

Axisl

EORE | No-op (0)

12




40. Return to iX Developer and the Tags pane. Create 9 more Tags and name them like in the image
below. Set the Access Right for each to Write and set the Data Type for each to FLOAT.

41. Assign the register addresses from RMCTools to their corresponding tag in iX Developer. Use the
below image for reference. Note that Command is assigned an address directly whereas the

remaining RMC addresses are assigned to Tags named Parameter 1 - 4.

Tag Controllers
Mame Data Type Access Right | Data Type DeltaRM. .. Read Expression Write Expression
InPosition DEFAULT Read INT32 400001 a 1 BitOIsSet
Halted DEFALLT Read INT32 400001 a 1 Bit15IsSet
PositionFeedback DEFAULT Read FLOAT 400003 a 1

" Position 'DEFAULT  Write 'FLOAT ! 0 T
Speed DEFAULT Write FLOAT a 1
Acceleration DEFALLT Write FLOAT o 1
Deceleration DEFALLT Write FLOAT 0 1
Command DEFALLT Write FLOAT 402049 a i
Parameter 1 DEFAULT Write FLOAT 402051 a 1
Parameter2 DEFALLT Write FLOAT 402053 a i
Parameter3 DEFAULT Write FLOAT 402055 a 1

o Persmeterd | DEFAULT e rLoaT A

Screen Configuration for Writes
42. Return to the Screen pane in iX Developer.

New Objects are added to link to the newly created Tags. Analog Numeric objects are used for
Position, Speed, Acceleration, and Deceleration Tags and a Button object is used to send a
command.

DELTA

COMPUTER SYSTEMS, INC.
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43. Each Analog Numeric is linked to its respective Tag (Position Numeric linked to the Position Tag,
Speed Numeric linked to the Speed Tag, etc). The max value for each of these Analog Numeric
objects is adjusted in the Property Grid to prevent sending a value outside the realm of each
parameter (ex. Max Speed = 25, Max Position = 20...). The Display Format is set to Decimal and
the Number of decimals set to 2. The Validate value on input box is also checked to send an
error message if a value out of range is attempted. A Button object to send a command is also
added but does not need to be linked to a Tag.

FTag | Acceleration - rT.ag g ' Position - ]
Display format Decimal ~ || Display format Decimal 3
Limit number of characters [_| {Eﬁ Limit number of characters [_| {é}
Mumber of characters 10 48 || Number of characters 10 48
Number of decimals 2 48 || Number of decimals 2 8%
Prefix 48} || Prefix 465
Suffix 485 || Suffix 85
Read only ] 484 || Read only | 8%
Validate value on input Validate value on input -

Validate value on display [ Validate value on display  [_]

Lower limit 0 485 || Lower limit 0 8%
Upper limit |50 48 || Upper limit {20 | (6]
Font size 20 - {§} Font size 20 = {?'}
Font family Tahoma w ||| Font family Tahoma -
Font color Il - | cooo0o 4 || Font color Il - o000 ]
Fill - & || Fin v ic}
Cutline - 7roDeg 4 || Qutline [l - 7FaDR &
Width 107 Width 107

Height 72 Height 72

Visibility 48 || Visibility 85
Security groups required | Select Security Groups..  ~ Security groups required | Select Securify Groups.. ™

14



Scripting for Writes
Scripting is incorporated to allow for reliable sending of data from the HMI to RMC. Without scripting,
the Beijer HMI will be unable to send a value of “0” for any of its parameters.

44. While on Screenl, click the Script button at the bottom of the screen to pull up the script page
for Screen1.

DELTA

COMPUTER SYSTEMS, INC.

0 S A e 33 i S O 3 A b S e TR A R0 AL T YO e
EREEES o -

| Layout Script Xaml Aliases

45. Add the following script shown in the red box.

ent class, start the call with
erate memoryleaks,

e3s an object that is not located in the c
sing events and timers be cautious not to ge
please see the help for more information.

o L b e

-1 m

namespace Neo.ApplicationFramework.Generated

{

10 using System.Windows.Forms;

using System;

using System.Drawing;

using Neo.ApplicationFramework.Tools;

using Neo.ApplicationFramework.Common.Graphics.Logic;
15 using Neo.ApplicationFramework.Controls;

16 using Neo.ApplicationFramework.Interfaces;

o wom
=

puklic partial class Screenl
{

vold Button Click(System.Object sender, System.Eventlrgs e)
{

float position = Globals.Tags.Position.Value;

float speed = Glokals.Tags.Speed.Value;

float acceleration = Glokals.Tags.RAcceleration.Value;
float deceleration = Glokals.Tags.Deceleration.Value;

L =]

I

1)

Globals.Tags.Parameterl.Set&nalog (position);
Globals.Tags.Parameter2.SetAnalog (speed);
Glokbals.Tags.Parameter3.S5etinalog (acceleration);
Glokals.Tags.Parameterd.Sethnalog (deceleration);

29

Globals.Tags .Command.SetAnalog (20) ;




The script makes it so, that upon clicking the Button object, the user selected values for Position, Speed,

Acceleration, and Deceleration are assigned to their respective Tag which is then sent to the RMC. The
final line of the script sends a value of 20 to the RMC Command register which executes a Move
Absolute with the entered parameter values.

Testing Writes

46. Download to the HMI and test the functionality. The In-Position box, Halted box, and Position
Meter should still be accurate. To test the newly added Command Parameters, use the Event

Log in RMCTools.

47. To access the Event Log, return to RMCTools. In the Project View pane, double-click the Event
Log at the bottom of the project tree.

Project Wiew

n

=21 I:?nject - [Project1]*

S RMC200 - [OBani20L]
+,_ij Modules
+L;,ﬂ Axes
+,_4_ Programming
_,-{ Curves
E Address Maps
+,_,E| Shortcut Sets
—'T'g Plots

48. Upon sending a move from the HMI, the command and parameter values should appear in the

Event Log in RMCTools as shown.

1d 18:00:26.263 (i) Command received.

- Move Absolute (20)
Position (pu):
Speed (pu/fs):
Accel Rate (pufs2):
Decel Rate (pu/s2):
Direction:
1d 18:00:13.993 (i) Command received.

- Move Absolute (20)
Position (pu):
Speed (pu/fs):
Accel Rate (pufs2):
Decel Rate (pu/s2):
Direction:
1d 17:59:57.102 (i) Command received.

—| Mowve Absolute (20)
Position (pu):
Speed (pu/fs):
Accel Rate (pufs2):
Decel Rate {pu/s2):
Direction:

.

1d 18:00:31.603 (i) Event Log last updated

[Axiz0]

15

10

17

16

Mearest (1)

[Axiz0]

0

10

25

25

Mearest (0)

[AxisO]
10
10
25
25

Mearest (0)

Source: Intern

Source: Intern

Source: Intern

16



49. The Actuator View can also be used to help test in RMCTools. The Actuator View can be
accessed under View -> Actuator View.

Actuator View w 0 X || Actuator View w 0

=0 IR =0

Modbus Plot Capture

The Beijer X2 Pro 7 can display short plots by reading the RMC plot data registers. With Modbus the
plots can be up to 512 data points in length.

50. In RMCTools, open the Address Maps and select Modbus. Add a Configurable Address with a
start address of 420001 and 512 registers.

IE Address Maps x” A¢ Axis Tools |Ever1t Log |gp\ot Manager |

S .
Start Address End Address Registers Map To Description
& Indirect Data Map i 200001 402048 1024 %MD8.0 Indirect Data Map, registers 0-1023
ron] 1 402049 402638 320 %%MD15.0 Command Area, Axes 0-31
F‘ DF1 (Allen-Bradley) 2 404097 412288 4096 | %MD 1024.0 Variables 0-4095
B PROFINET Data Records 3 412289 414336 1024 %MD23.0 Image Upload/Download Area, registers 0-1023
& IEC 4 420001 421024 512
*

51. To select the register address to map to, click [...| in the respective Map To box. Browse to Plots -
> Plot 0 -> Static Upload Area and choose Data Set 0 (%MD640.0 for the RMC200).
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Start Address End Address
1] 400001 402048
1 402049 402638
2 404097 412238
3 412239 414336
4 420001 421024

*

Registers Map To Description
1024 °%MD8.0 Indirect Data Map, registers 0-1023
320 %MD15.0 Command Area, Axes 0-31

4096 %MD1024.0
1024 %MD23.0

512

Variables 0-4095

Image Upload/Download Area, registers 0-1023

Address Selection Tool

&

I e W

-1 Axes
-1 Variable Table
-{_] Discrete I/O
1 Tasks
-{_] Controller
-1 Address Maps
-1 Plots
=1 Plot0
+-{_ Status/Configuration
+-_1 Dynamic Upload Ar
=-{_1 Static Upload Area
L BFiot 0, Data Set 0, Sample 0
-4 Plot 0, Data Set 1, Sample 0
- 4p Plot 0, Data Set 2, Sample 0
4 Plot0, Data Set 3, Sample 0
- 4 Plot 0, Data Set 4, Sample 0
-4 Plot 0, Data Set 5, Sample 0
-4 Plot 0, Data Set 6, Sample 0
-4 Plot 0, Data Set 7, Sample 0
- 4p Plot 0, Data Set 8, Sample 0
4 Plot0, Data Set 9, Sample 0
- ¢ Plot 0, Data Set 10, Sample 0
-4 Plot0, Data Set 11, Sample 0
-4 Plot 0, Data Set 12, Sample 0
- 4p Plot 0, Data Set 13, Sample 0
-4 Plot 0, Data Set 14, Sample 0
4 Plot 0, Data Set 15, Sample 0

Overview for the Selected Address
Register Description:
Flot 0, Data Set 0, Sample 0
Register Address:
%MDE40.0
System Tag:
/A
Accessibility:
Read Only
Data Type:
REAL

v

Address: | %MD640.0

Cancel Help

52. The Configurable Address should now look the same as the image below.

Start Address
0 400001
1 402049

2 404097
3 412789
4 420001

*

End Address

402048
402688
412288
414336
421024

Registers
1024
320
4096

Map To
%eMD3.0
%MD 16.0
FeMD1024.0
1024

512

%MD 23.0
%MDGe40.0

Description
Indirect Data Map, reagisters 0-1023
Command Area, Axes 0-31
Variables 0-4035

Image Upload/Download Area, registers 0-1023

|Plot 0 Static Upload Area (Data Set 0), registers 0-511

53. Return to iX Developer and open the Tags pane. Create a new Tag and set the following

parameters:

o 0 T W

Name the tag Plotdata
Set the Read Access to Read
Set the Data Type to FLOAT
Set the FLOAT variable to an array by increasing the Array Size to 512 in the pop-up box
as seen below
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Parameter3 DEFALLT Write FLOAT
Parameter4 DEFALLT Write FLOAT

402055
402057

- 420001...4...

1 | Plotdata DEFAULT Read {FLOAT([512]

Data Type
DEFALLT
INT16
INT32

» FLOAT
DOUBLE
DATETIME
STRING
BOOL
UINT 16
UINT32

Size

O

HoH R e e e

a

0

a
Array Size n

Cancel

54. Create a second screen in iX Developer and add a Chart object. Change the Chart Type to Fast
line. Expand the Extended drop down and uncheck Show legend to make the plot easier to

read.

55. Click the three-dot ellipsis next to Series to open a dialog box. Click Add to add a new data series
and set the X Tag to the Plotdata array. Uncheck the Show Labels box to make the graph easier

to read.

Property Grid > X

Search Lip ¥ ]
(=T

Series !

Chart type

Header Chart ié}

3D view [} ié}

Style Chrome =

Font size 1Al - Chart Series

Font family Tahoma v

Font color .' 000000 ﬁ? Remove

Fill - |FFFFFF Name X Tag ¥ Tag

Width 514 1 Series

Height 274

Visibility ﬁ}

Security groups required | Select Security Groups ~

> Text

Audit trail description
Delay Mouse / Touch Input []
Delay Period (ms)
Active

Show header
Show legend
Show scale

Auto-scale X-axis

HHHH!! =
B GEGE

Show X-axis grid

Size

Labels

Calor Thickness Axis Type Show La...

. st ks

Carce
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Testing Plot Capture

Buttons were added on both Screen 1 and Screen 2 to allow the user to change between screens.

Previous

56. Download and run the project. The Chart will show plot data and will update real-time. Like the
Capture button in RMCTools, it will not overwrite after the chart is filled until new position data
is received.

57. The sample rate of the plot in the RMC can be reduced to increase the plot duration at the
expense of resolution.

58. To change the sample rate return to RMCTools and open the Plot Manager. In the Plot
Templates pane, click the Edit Plot Templates button to open the Plot Template Editor.

Project View w B X Task Monitor
=-4=H] Project - [Project1]*
Bg RMC200 - [Obani20]
I_ﬂ Modules

s -8 Axes
B - Programming & Address Maps | = Plot Manager X

LA Curves E sl =) | Plot0-HMICapturel | Capture:

- Address Maps

| 53 Edit Plot Templates I
= 1 - Outerd
= 2 - Outer2

59. In the Plot Template Editor, the Sample Interval controls the sample rate. Reducing the sample
rate from 0.001 sec to 0.05 sec will multiply the plot length by 50.
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Plot Template Editor

Plot Templates
4 Add Plot Template 0 - HMICapture1
=0 - HMICapturel
Flot Name: HMICapturel
Sample Interval: 0.05 2| cec
Capture Duration: 5 ? SEeC

Trend Duration: 30 = sec

Plotted Data Ttems

Register /Value

Pen Color

(®) Default Plot for Axis: |0 - Axisd ~

RMCTools will manage which registers are plotted.

() Custom Plot
The user will manage this plot's settings.

Axis0 Target Position
Axis0 Actual Position
Axis Target Velodity
Axis0 Actual Velocity
Axis0 Control Output
Axis0 Status Bits

Axis Position Mean Squared Err

Trigger Settings
Automatic Trigger: Motion Commands issued to Axis 0
Rearm Mode: Automatic

Pre-Trigger Percent: 0%

Plot Templates Used: 1lof8
Template Memory Used: <0.1%
Total Data Items Used:  5of 128

Cancel

Help
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